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INTRODUCTION TO THE WORD WORD 
PROCESSOR 
Writing a Conference Call letter 

 

BEFORE YOU BEGIN 
Lesson 1 makes the assumption that you are already familiar with the Windows1 
computing environment, though you may not be an expert in its use.  Thus, if you are 
using a computer in a lab at school: 

• you know where to find the computer lab on campus; 
• you know how to turn the computer on; 
• you know how to log on to the system (if necessary, using your login name and 

password; 
• you are familiar with the Windows, Icons, Menus, and Pointers (the so-called 

WIMP interface) with which you interact with the machine. 

Lesson 1 also assumes that you have a copy of the WorkDisk and the PowerPoint disk 
which accompany these tutorials. 

You should also have prepared (formatted and labeled--with the disk’s name and 
your own name clearly written on the label) the following five other disks on which to 
save your work2: 

• a disk named WkDskBkp on which you should make a backup copy of the contents 
of the WorkDisk3; 

                                                 
1 The term “Windows” describes the family of computers built around microprocessors designed by Intel Corporation.  For this 
reason they are sometimes called “Wintel” machines.  In this text we will refer to them all with the generic name “Windows 
computers”. 
2 For the sake of these tutorials we will assume you are using 3.5" floppy disks rather than, for example, 
zip disks. 
3 To make a backup copy of a disk, put the original disk (in this case the WorkDisk or the PowerPoint 
disk) in the floppy disk drive, then double click on the My Computer icon on your desktop and right click 
on the 31/2 Floppy (A:) icon.  In the menu that pops up, select Copy Disk... and then follow the directions 
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• a disk named PwrPntBkp on which you should make a backup copy of the 
contents of the PowerPoint disk; 

• four blank, formatted, 1.44 mbyte disks named Data, DataBkp, AccessDocs and 
AccessDocsBkp on which to save the files you will create using these tutorials. 

If you do not have all these disks at hand, get them ready now before proceeding 
with this tutorial.  Getting them ready means: 

• having each one formatted for a Windows computer; 
• putting a blank label on each disk; 
• writing your name on each label, along with the name of the disk indicated above. 

You are now ready to learn about the Word word processor.   
 

 
 A caveat before you begin:  You'll find it easiest to use the tutorial if you follow 
 the directions carefully.  On computers there are always other ways of doing 
 things, but if you wander off on your own be sure you know your way back! 
 

 

LEARNING OUTCOMES 
Words are among the most important tools of a teacher's trade.  You owe it to yourself 
and to your students to use words to the best of your ability, and the word processor is 
the perfect tool for such a purpose.  As you will see, the word processor makes 
revisions easy and thus encourages you to correct errors in grammar, spelling, and 
style. 

In this tutorial you will learn the steps required to produce a word processor 
document from scratch.  These include 

• opening and naming a new word processor file 

• entering and saving a document 

• updating and simple formatting of a document 

• checking the document for spelling and grammar errors 

• printing a first and final draft of the document 

• making a backup copy of the document 

                                                                                                                                                             
on the screen.  You’ll be asked to replace the WorkDisk or the PowerPoint disk with the Backup disk half 
way through the process, so keep your eyes on the screen and your wits about you! 
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1.1 OPENING AND NAMING A NEW WORD PROCESSOR FILE 
Before you can use Word you must first open the program. 

Click on the Start button in the lower left corner of the screen, then from the 
Programs submenu select Microsoft Word (you may need to choose from 
the Word Processing or Microsoft Office submenu--Fig. 1.1) 

 
Fig. 1.1 Open Microsoft Word  by clicking on the program icon 
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If you can find Microsoft Word for yourself, select the program from the Office or 
word processing submenu.  Otherwise get help from a friend, or your instructor, or 
from the lab supervisor. 

After you have opened Word, you should have a new blank document open on 
your screen. 

If this is not the case, then just select New from the File menu 
Look at the name of the new file at the top left of the screen (Fig. 1.2). 

 
Fig. 1.2 Window for a new Word document 

As you can see, the new file is named "Document1".  The file is so called because you 
haven't yet given it a name.  It's always a good idea to give a new file a name or title of 
your own immediately and save it on the disk on which you intend to keep it. 

This is easy enough to do.  Here are the steps. 

Put your Data disk in the floppy disk drive (drive A:) and select Save As from 
the File menu 

Word displays the Save As dialog box (Fig. 1.3), prompting you among other things 
to type the name of the file and to select the disk on which you want to save it. 

Click on the Save In: box and notice the drop down menu that appears listing the 
various disk drives on your computer (Fig. 1.3) 

If you are saving your files on a regular 3.5" floppy disk drive, your disk will be in 
drive A:. 

Click on the disk drive called 31/2 Floppy (A:) to open it 
Next you need to open a new folder on your disk in which you are going to store 

your word processor files. 

Click on the Create New Folder icon (Fig. 1.3)  in the Save As dialog box 
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Click on this icon to
Create New Folder

List of disk drives
and other devices

on your system

Click here to bring up
the list of disk drives

on your system

 
Fig. 1.3 The Save As dialog box 

You'll now see a dialog box to name the new folder (Fig. 1.4). 

Default button
(note the slightly heavier border)

Activated when you hit the Enter key

 
Fig. 1.4 New Folder dialog box 
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For the new folder’s name type WPFiles and click on OK 

In the File name: data entry box type ConfCall to replace the default name 
and press Enter (or click on the Save button) 

The Save As option thus allows you to name your files and at the same time 
determine the location (the folder, on a particular disk) on which you want to store 
them.  In effect, by naming the document and specifying the location on which it will be 
stored, you are reserving a space for it on the disk. 

You should now be looking at a screen with the name of your file (ConfCall) in the 
Title Bar (Fig. 1.5). 

Notice that Word will usually automatically append the .doc extension on all word 
processor files.  Beneath the Title bar is the Menu bar; beneath the Menu bar you can see 
the Tool bars with tab, margin, and spacing buttons among others. 

You will get to use these buttons later in this lesson and in Lesson 2.  The various 
buttons give you direct access to tasks which you would otherwise have to find in one 
of the menus.  In other words, the Tool bars are there to save you time. 

Before you go on, position the mouse pointer over each button in the Tool 
bars and read the brief description which pops up for each one 

Below the ruler is a blank page with the cursor waiting in the top left corner, ready 
for you to type in your letter (Fig. 1.5). 

These are some of the tools in the
Formatting toolbar

Click here to see more
formatting tools This is where the

Standard Toolbar begins

 
Fig. 1.5 Screen for a newly named Word processor document 

 

1.2 HELPFUL HINTS WHILE USING THE WORD PROCESSOR 
You will shortly type the Conference Call letter into the word processor.  But before you 
start, read the helpful hints that follow. 
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Toolbars 
Word has Standard and Formatting toolbars towards the top of the screen with icons for 
commonly used tools that you can click on to quickly carry out many word processing 
tasks. 

Figure 1.5 above shows you where these two tool bars are on your screen.  You’ll get 
to know several of these tools (and the tools on other toolbars) as you work your way 
through these tutorials.  You should take a look at the Standard and Formatting tools 
now in anticipation of using them as you go along. 

Move the mouse pointer up to the toolbars and, without clicking, just 
position the pointer on one tool icon at a time till you see the description of 
the tool pop up on the screen 

Read the description and familiarize yourself with each of the tools now 

Word processing is not the same as using a typewriter 
As you type at the computer keyboard, the letters will appear on the screen.  If you are 
new to word processing, you need to be aware of the one major difference between 
using a computer and using a typewriter. 

When using a typewriter you have to move the carriage back at the end of every line 
so you can start typing at the beginning of the next line on the page.  This is called a 
carriage return. 

When you use a word processor, however, the system takes care of the end of each 
line.  As you type away in word processing, the program is aware that you are getting 
to the end of the line, and it will automatically "wrap around" a word to the beginning 
of the next line if the word doesn't fit completely on the end of a line.  This means that 
you don't have to worry about hyphenating words that are broken up over two lines—
unless you want to, of course. 

So the only time you need to hit the Enter key is at the end of a paragraph, whether the 
paragraph be one word, one line, or several lines. 

Type the following passage so you can practice this now (remember, don't 
press the Enter key until you get to the end of the paragraph)--don’t worry if 
your text wraps around differently; the lines on your screen may be longer or 
shorter, which doesn’t matter for this exercise 

And though he tried to look properly severe for his students, Fletcher Seagull suddenly saw 
them all as they really were, just for a moment, and he more than liked, he loved what he 
saw.  No limits, Jonathan? he thought, and he smiled.  His race to learn had begun.1 

Now press Enter at the end of the paragraph 

                                                 
1 From the book "Jonathan Livingston Seagull: a story" by Richard Bach.  New York, NY: Avon, 1970. 
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Notice how the word processor took care of the end of each line. 

There are two cursors you need to know about 
When you word process on a Windows computer there are two independent cursors you 
need to know about.  One is called the I–beam cursor and the other is called the Insertion 
point cursor (Fig. 1.6). 

 
Fig. 1.6 The two kinds of cursors 

The I–beam cursor is so called because it looks a bit like an uppercase "I".  It becomes 
an arrow when positioned outside the page borders.  Try the following for practice. 

Roll the mouse around and notice how the I–beam cursor follows along and 
changes to an arrow each time you cross the page border 

The Insertion point cursor (which blinks on and off on the screen and is not directly 
controlled by the mouse) is so called because it indicates exactly where characters will 
appear in the text when you type at the keyboard.  The I–beam cursor is under the 
control of the mouse and allows you, by clicking on the left mouse button, to position 
the insertion point cursor anywhere in the text of your document.  Practice will help 
you understand how this works. 

Use the mouse to move the I–beam cursor on the screen so it is positioned 
immediately before the word "Fletcher", then click the left mouse button and 
roll the mouse away to your right 

The insertion point cursor, which originally was positioned at the end of the 
Livingston Seagull quote, should now be blinking on and off right in front of the word 
"Fletcher."  Notice how you used the mouse and the I–beam cursor to change the 
position of the insertion point cursor. 

Now position the I–beam cursor immediately before the word "though" in the 
first line 
Click the left mouse button so as to move the insertion point cursor to the 
same place 
Type the word "even" followed by a space 
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Finally, click at the end of the paragraph (after the final period) 
Do you see how it works?  This takes a bit of getting used to, but the more you 

practice the more natural it will become.   

Scrolling through a document 
On the right of the screen you have a vertical scroll bar; at the bottom of the screen you 
have a horizontal scroll bar.  At either end of the scroll bars are arrows pointing in 
opposite directions.  Clicking on these arrows will scroll a document up or down, left or 
right, depending on which arrow you select.   

Try this now by clicking on the scroll arrows to move the scroll box in the 
scroll bar 

You also can scroll by positioning the mouse arrow on the scroll box itself, holding 
down the left mouse button, and dragging the box in the scroll bar. 

Try this, too, then click above or below the small box inside the scroll bar to 
see how this causes the document to scroll in jumps, from section to section 

You can also scroll and position the cursor very precisely by using the arrow key 
pad on the keyboard.  When you have finished experimenting make sure the whole 
Seagull quote shows on the screen. 

Correcting errors while entering text 
If you see you've made a mistake and you want to fix it before you go on, use the mouse 
to put the insertion point cursor immediately after the mistake, press the Backspace key 
(Fig. 1.7) as many times as necessary to remove the incorrect character(s); then retype 
the data. 

 
Fig. 1.7 The difference between the Backspace and Del(ete) keys 

You can also use the Del(ete) key for this purpose.  To use this key you position the 
cursor immediately ahead of the character(s) you want to delete.  So the Backspace key 
works backwards and the Del(ete) key works forwards (Fig. 1.7)  After you’ve deleted 
the text, you would use the mouse to click at the point in the document where you want 
to resume typing.  Try the following example. 

Position the cursor right after the word "even" in the first line, press the 
Backspace key till the word "even" and the extra space have been deleted, 
then click at the end of the paragraph 



ESSENTIAL MICROSOFT OFFICE 2000: Tutorial for Teachers 
Copyright © Bernard Poole, Rebecca Randall, 2000.  All rights reserved 

 

14

Undoing unintended actions 
If you do something you didn't intend, select Undo from the Edit menu. 

Check this option in the Edit menu now so you can see it for yourself 
Removing unwanted Returns (using the Hide/Show ? option) 
You can have Word show you exactly in your document where you hit the Enter key 
(say, at the end of paragraphs).  Here's one way you can do this. 

Select Options in the Tools menu 
The Options dialog box pops up on the screen (Fig. 1.8). 

Put a check mark
in this box

 
Fig. 1.8 The Options dialog box 
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In the Formatting marks section, click to put a check mark in the box next 
to Paragraph marks, then click on OK 

Notice the ? symbol where you hit Enter at the end of the paragraph.  Another 
(quicker) way to turn on this option is to select the ? icon in the Formatting toolbar. 
Here’s how you do this. 

Go to the Formatting toolbar towards the top of your screen and click on the 
small arrow at the end of the toolbar to bring up the set of other tools 
available to you (Fig. 1.9) 

Click here to see
the other set of

Formatting tools

This is the tool to
show or hide

Paragraph marks

 
Fig. 1.9 Showing or Hiding Paragraph marks 

Position the cursor at the beginning of the third line of your text, then hit the 
Enter key twice 

Notice again the ? symbols that show you where you hit the Enter key (one at the 
end of the previous line, and the other on the empty line ahead of the cursor). 

Now remove the Paragraph marks you just entered by pressing the 
Backspace key twice 

 

1.3 ENTERING AND SAVING A DOCUMENT 
Practice makes perfect 
The best way to get the hang of using the word processor is by practice.  First of all, 
you'll need to clear the Seagull quote off the screen.  You don't want to save it as part of 
the Conference Call letter, so here are the steps to get rid of this unwanted text. 

Choose Select All from the Edit menu (or drag across the whole paragraph) 
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Press the Backspace key once to remove the highlighted text from the 
document 

Notice that the Backspace key removes all highlighted text. 

Entering the Conference Call letter 
Fig. 1.10 below has the full text of the Conference Call letter. 

 

Fig. 1.10 Conference Call Letter 

It also shows where all the Paragraph marks (?) are.  This is to help you remember to hit 
the Enter key only where necessary, not at the end of every line. 

As you type, Word is probably set to automatically warn you of any spelling or 
grammar errors it finds (by underlining them on your screen).  This will occur as you 
type the contents of Fig. 1.10.  Don’t worry about these warnings for now.  You will also 
notice that Word will think that you are writing a letter once you type the first address 
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at the top of the page.  Just ignore this, too, and click on Cancel when prompted by the 
Office Help icon in the lower right corner of the screen. 

Go ahead and type in the complete text of the Conference Call letter 

Saving the document 
Save the Conference Call letter as you go along.  A momentary loss of power is enough 
for you to lose all your work.  Once the document is saved you should go back and 
correct any errors you made, and then save it again to replace the previous version. 

From the File menu select Save (or press Ctrl-S) 
Remember:  when you save a document with the same name as before, you are 

replacing the earlier version.  You won't be creating a second copy. 
The quickest way to save your work is to press Ctrl–S on the keyboard.  The Ctrl key is 

in the lower left corner of the keyboard.  It is called the Control key.  Locate it now; 
you'll be using it a lot as you become more familiar with Word.  It is always used in 
combination with one or two other keys.  Ctrl–S, for example, is executed by holding 
down the Ctrl key and simultaneously pressing the S key. 

You'll learn more keyboard commands as you work your way through the tutorials.  
For ready reference you will find on the inside back cover of this book a list of the most 
frequently used keyboard commands. 

You should get used to using the Ctrl–S frequently—say once every 15 minutes or 
so—as a protection against losing your work.  Until you have your own Uninterruptible 
Power Supply (UPS), you should become very conscientious about executing that Ctrl–S 
command which quickly saves your work to the disk on which you originally saved it.  
The system uses the same name and the same location as before. 

 
1.4 UPDATING AND SIMPLE FORMATTING OF A DOCUMENT 
Now that your letter is saved on disk, you can make any revisions you want. 

Word processing allows you to treat text like modeling clay.  You can easily mold 
your words and ideas.  You can change margins, put in underlines, italics, boldface, and 
so forth.  You can correct errors, move text around, lay it out on the page—all at the 
touch of a few buttons.  In the next lesson you'll have an opportunity to become quite 
sophisticated in this regard.  But let's keep it simple for now. 

You may need to refer back to Fig. 1.10 while you complete the next few sections. 
If you find all those Paragraph marks distracting, turn them off by selecting 
Options from the Tools menu, and remove the check mark next to 
Paragraph marks in the Formatting sections of the dialog box, and click OK 

Inserting the date 
There is no date on the Conference Call letter in Fig. 1.10.  A letter is incomplete 
without a date so here are the steps to have Word put today's date in the letter. 
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Use the I–beam cursor to position the insertion point cursor right after the 
zip code in the first address at the top of the page, then press Enter 

The cursor should now be waiting at the beginning of the next line. 

From the Insert menu select Date and Time... 
The Date and Time dialog box (Fig. 1.11) offers you a list of several formats for the 

date and for the time of day. 

 
Fig. 1.11 Date and Time dialog box 

Decide on the format you like best and click on it to select it, then click on OK 
(or just double click on the format you chose) 

You will appreciate the advantage of allowing Word to insert the date for you when 
you save the letter as a template.  When you use the template, or print a Conference 
Call letter, for example, the date will be adjusted to reflect the current date. 

Adding text 
This is an activity which is fundamental to the whole process of writing.  On a 
typewriter it is usually messy, and often difficult to do.  When you use the word 
processor, however, it is a simple task. 
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There is no limit to the extra details that could be added to the letter, but for the sake 
of this exercise you will add just one sentence to the next to last paragraph to help the 
parents appreciate what Aaron will get out of his experience at the Institute. 

Position the insertion point cursor so it is right at the end of the paragraph 
which begins "The institute has a wonderful reputation..." 
Press the space bar twice and type the sentence: 

He would thus have the opportunity to meet and make friends with 
others of his own age and academic ability. 

Read over the sentence you just typed to check for errors.  Correct any you may 
have made.  Before you go on to the next section you should save what you have done 
so far. 

Press Ctrl–S to save the changes you have made to the letter 

Removing text 
There are several ways of removing text.  In a moment you'll learn how to highlight a 
block of text in order to move or delete larger sections of text.  But if all you want to do 
is remove a few words, or a short sentence, the quickest way is to use the Backspace 
key. 

Practice this now.  You are going to remove the second sentence of the second 
paragraph.  This second sentence begins "I have attended the facility myself ... ". 

Position the insertion point cursor so it is in front of the "A" at the beginning 
of the third sentence of the same paragraph—the sentence that begins 
"Aaron would take part ..." 
Press the Backspace key as many times as is necessary until the second 
sentence of this paragraph is removed from the letter 

You'll find the automatic repeat feature of the keyboard (activated by holding down 
a key such as the Backspace key) will come in handy for a delete operation like this. 

Press Ctrl–S again to save the changes you just made 

Changing text 
The letter overuses the word "program."  The word appears once in the first paragraph 
as it is, and then is used twice in the final paragraphs.  To improve the letter it would be 
better to rewrite the first sentence of the next to last paragraph to read: "The Institute 
has a wonderful reputation for its offerings for both children and adults." 

To change the existing sentence, follow these steps: 

Place the cursor between the period and the "s” at the end of the first 
sentence in the second paragraph (right at the end of the word "programs" 
but before the period) 
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Use the Backspace key to remove the text that follows the word “for” 

Make sure there is still a space after the word “for”, then type the phrase “its 
offerings for both children and adults.” 

One last change you need to make is to the telephone number in that last sentence.  
A common error with numbers is called transposition, where one accidentally reverses 
the order of digits.  The number is supposed to be 772–3232, not 3223. 

Position the cursor just at the end of the telephone number 

Press the Backspace key 2 times, then type the digits "32", and once again 
press Ctrl–S 

At this stage your Conference Call letter should look much the same as Fig. 1.12. 

 

Fig. 1.12 Intermediate update to the Conference Call letter 
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Selecting (highlighting) a block of text 
Highlighted text is text that stands out from the rest of the document either because the 
background turns black and the text white (black and white monitors) or because the 
background turns the color you (or someone else) set for the highlighting color on your 
Windows computer. 

When you highlight text, you can do things to it (delete it, move it, copy it, change 
the margins set for it, and so on) without affecting the rest of your document. 

You can highlight a single character... 

Locate the I–beam pointer on the screen and use the mouse to move it so it 
is immediately before the "H" in “Hodge" in the address at the top of the 
letter 
Hold down the left mouse button and carefully drag across just the "H" at the 
beginning of the word so that it becomes highlighted 

This latter operation is tricky the first few times you try it.  The secret is to keep the 
left mouse button depressed—and don't panic!  So, if you drag across more than just the 
"H", keep your finger on the left mouse button and drag back and forth until you have 
just what you want highlighted.  Practice this—you can select as much or as little as you 
want.  Remember, you're in control.1 

Let go of the left mouse button when just the "H" is highlighted, then click 
anywhere in the text to remove the highlighting (i.e. to deselect selected text) 

If you're not used to doing this it may seem awkward at first—like the first time you 
tried to ride a bicycle, perhaps.  But you'll get used to it.  Try it a few times on different 
letters. 

You can highlight a single word... 

Position the I–beam anywhere over the word "Elementary" and Double click 
the left mouse button (or drag across the word using the mouse) 

The single word "Elementary" should be highlighted on the screen. 

Click anywhere in the text to remove the highlight 

Try this on a few more words till you're comfortable with the action. 
You can highlight a line of text... 

                                                 
1 If you're new to word processing, the secret here is: don't panic!  No matter how much you might think 

to the contrary, when you're working with computers you are in control—as long as you know what 
you're doing.  The computer is just a dumb machine designed to serve your information processing 
needs.  These tutorials will help you bring this dumb machine under your control. 
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Position the cursor in the margin to the left of the line you want to highlight 
(the cursor changes from an I-beam to an arrow pointing in at the line at the 
edge of the text) and click on the left mouse button  

There you have it!  The whole line is highlighted. 
Click anywhere in the text to remove the highlight 

Try this on a couple of different lines. 

You can highlight several selected lines... 

Once again, move the cursor into the margin immediately in front of the first 
word of the first paragraph (the cursor becomes an arrow pointing in at the 
line) 

Hold down the left mouse button and drag up or down to select (highlight) a 
couple of lines, then let go of the left mouse button, and click anywhere in the 
text to remove the highlight 

You can quickly highlight an entire paragraph... 

Move the I–beam anywhere in the first paragraph, click quickly 3 (three) 
times on the left mouse button and notice the effect this has of highlighting 
the entire paragraph; click anywhere in the text to remove the highlighting 

You can highlight an extended area (or block) of text... 

Place the I–beam either at the start or end of the text you want to select and 
click the left mouse button to put the insertion point cursor there 

Scroll, if necessary, to the end of the section you want to highlight, then hold 
down the Shift key and click at the end of the block of text 

Notice that the whole section is highlighted. 

Click anywhere in the text to remove the highlighting 

You can quickly highlight an entire document... 
You should be getting the hang of this highlighting activity by now.  You can drag the 
mouse to highlight several paragraphs or even an entire document of several pages.  
However, dragging through a 50 page document would quickly become tedious.  So 
Word provides a short cut to select an entire document.  You may recall using this 
feature earlier in the tutorial. 

From the Edit menu at the top of the screen choose Select All 
Simple as that!  To remove the highlighting, just click anywhere in the document as 

usual. 
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Changing margins and using the Word Indent Markers 
The letter is nearly ready to be printed.  One style for letter–writing is to position the 
first address (the address of the sender) at the top right of the first page.  The closing 
signature would then be aligned on the right side of the page at the end of the letter 
(Fig. 1.13). 

 
Fig. 1.13 Final version of the Conference Call letter 

To carry out these changes you will need to learn how to use the indent markers. 
Using the Indent Markers 

 Before you go on, remember that the tip of the mouse arrow is the 
 hot spot.   Moving the small indent markers is a delicate operation, 
 so be sure to point with the tip of the mouse arrow. 
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Indent Markers are used to adjust the first line and the left and right margins of 
paragraphs.  To use the indent markers you must have the ruler showing on the screen 
at the top of your document (Fig. 1.14). 

Hanging Indent

Left Indent

First Line Indent

 
Fig. 1.14 The Word ruler and the Indent markers 

If you do not see a ruler with hash marks on it you’ll need to make sure it is 
displayed on your screen.  You can either hide or show the ruler by selecting the Ruler 
option in the View menu. 

To check this out, double click on the View menu to show all the menu 
options, then select Ruler 
Do this a couple of times—and make sure you end up with the ruler showing 
at the top of your document 
Click anywhere within the first paragraph of the letter before completing the 
next exercise (this tells Word which piece or paragraph of text to reformat) 

On the left side of the ruler, at the 0" hash mark, you can see the indent markers that 
set the Hanging Indent, the Left Indent and the First Line Indent (Fig. 1.14).  These 
markers move together when you drag the small box (the Left Indent marker) on which 
the lower of the two pointed markers sits.  Follow these steps to try this now. 

Use the mouse to drag 1/2” to the right (to the 1/2” hash mark) the Left 
Indent marker on which the Hanging Indent marker (the lower of the two 
pointers) sits 

Notice that the First Line Indent marker (the upper pointer) shifted right along with 
the Hanging Indent marker (the lower pointer) and that the whole paragraph moved to 
the right half an inch. 

To independently move the First Line Indent marker (the upper marker), point at it 
with the tip of the mouse arrow and drag to the left or right (you won't be able to drag 
further left than the left edge of the page). 

Try this now 
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To independently move the Hanging Indent marker (the lower of the two markers) 
you just point at it and drag it to the left or right (again you won't be able to drag 
further left than the left edge of the page). 

Try this now 

The following directions will give you more practice using these indent markers.  
You will be setting the indent markers for all the paragraphs in the body of the letter. 

First, click before the first word of the first paragraph to position the 
insertion point cursor there 

Now, scroll down if necessary till you can see the end of the letter, then, while 
holding down the Shift key, click at the end of the third and last paragraph 

All three paragraphs of the letter should now be highlighted. 

First drag all the indent markers so they are at the left edge of the page (back 
at the 0” hash mark) 

Now position the tip of the mouse arrow on the First Line Indent marker 
(the indent marker on top of the others) and slide it over to the 1/2” hash 
mark on the ruler 

Notice that the left margin of each paragraph (except for the first line) is now set at 0 
inches and the first line of each paragraph is set at 1/2". 
Practice makes perfect 

If this is the first time you've used these markers you may still feel uncomfortable 
working with them.  More practice will cure that.  You want the final version of the 
Conference Call letter to look like Fig. 1.13 (a couple of pages back).  You need to adjust 
the left margin for the first address at the top, and for the sign off at the end of the letter. 

Select (highlight) the first address and date lines at the top of the letter 

Point at the Left Indent marker (the small box at the bottom of the indent 
markers) and drag all the indent markers together over to the 3.5" hash mark 
on the ruler, then click anywhere in the text to de-select the highlighted text 

The address and date should now be lined up on the new margin.  If you weren't 
successful the first time, just go through the steps again until you get the hang of it. 

Next scroll down to the end of the letter if it doesn't show on the screen 

Select the lines that begin: "Sincerely yours," and conclude with "Donna 
Hendry" and “Department Chair”  (including all the blank lines in between) 

With these lines highlighted, move both the indent markers across to the 
3.5" hash mark on the ruler, as you did for the address at the top of the page 

Press Ctrl–S to save this (almost final) version of the document 
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1.5 CHECKING THE DOCUMENT FOR SPELLING ERRORS 
Microsoft Office 2000 comes with a spelling checker, and no matter how good you might 
think your spelling is, you would do well to take advantage of this fast, effective tool for 
catching spelling errors or typos. 

Encourage your students to use a spelling checker when they are proofing their 
word processed work.  The system will highlight any words that it cannot find in its 
dictionary and may make suggestions for words or spellings the student intended.  It 
can thus help your students become better spellers, even broaden their vocabulary if 
they are curious enough to check out the meanings of the many words they've never 
come across before.  However, it cannot spell for them—yet!  Nor can it correct errors 
such as the misuse of "to", "too", and "two"! 

A spelling checker is not an alternative to proofreading.  Tell your students they 
should always proofread their work on the printed page (in hard copy form) after they 
have run it through the spelling checker.  It also would be a good idea to have another 
student proofread it.  Assessing a classmate’s work is a valuable learning experience. 

Accessing the spelling checker 

From the Tools menu select Spelling and Grammar... 
This will bring up the dialog box shown in Fig. 1.15 

 
Fig. 1.15 Spelling and Grammar dialog box 
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The Word spelling and grammar checkers are probably already working for you if 
those functions are in automatic mode, if you see strange looking underlines under 
some of the words you typed.  If Word highlights a word or phrase, this does not 
necessarily mean there is anything wrong with it.  You still have to be able to tell if you 
have made an error and also know how to correct it.  Remember, the computer is just a 
dumb machine—a tool to assist your intelligence, not replace it! 

It’s useful to know how to turn these functions on or off.  Here are the steps. 

Click on Options in the Spelling and Grammar checker dialog box 
This will bring up the screen illustrated in Fig. 1.16. 

 
Fig. 1.16 Spelling Checker dialog box 

Check that the options to Check spelling as you type and Check grammar 
as you type are selected then click on OK 

If you tell the Spelling Checker to check your document, and it has "No suggestions" 
for a word highlighted, the dialog box gives you the option to have the Spelling 
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Checker Resume (because the word is correct); or Ignore All occurrences of the same 
word in your document (because you don’t want the Checker to stop for them again); 
or Add the word to the custom dictionary (so it won’t be flagged in future documents 
you work on).  This is generally useful for proper names. 

On the other hand, if there are suggested alternatives, the Spelling Checker will give 
you the additional options to Change the word; Change All further occurrences of the 
word; or Autocorrect (which will result in Word selecting the first suggestion in the list). 

At one time or another you will find all these features useful, so you should take the 
time to check them out now. 

Work your way through the Conference Call letter now and correct any 
spelling or typing errors you may have made 
Better save your work one last time (press Ctrl–S) 

For the most part the Spelling Checker is intuitive, and one of the best things you 
can do at this time is take a few minutes to browse through the various selections until 
you get a feel for what the Spelling Checker can do. 

In Lesson 2 you will have an opportunity to make more extensive use of the Word 
Spelling Checker. 

 

1.6 PRINTING A FIRST DRAFT OF THE DOCUMENT 

Print Preview–ing your work 
It is always useful to preview your work on screen before sending it to the printer. 

From the File menu select Print Preview now to check this out 

Running off a draft copy 
Press Ctrl–P (or select Print from the File menu) to start the printing process 

What kind of printer are you using? 
Word will present you with a Print dialog box similar to that shown in Fig. 1.17.  If you 
have a laser printer the quality is always "Best."  But if you have a dot matrix, daisy 
wheel, or inkjet printer you can choose the quality of output you desire. 

If you’re using a dot matrix printer or an inkjet printer, click on the option to 
print a fast or draft copy this first time through 

Printing a range of pages 
With regard to Page Range, the All button is selected by default.  Should you want to 
print a subset of the pages of a long document, say from page 3 to page 6, you would 
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click in the radio button next to Pages (see Fig. 1.17 on the next page) and enter the page 
numbers of the range of pages in the data entry box (ex. 1,3,5-12).  

 

Fig. 1.17 Typical Windows Print dialog box (yours may be different) 

Setting the number of copies 
Word also asks you how many copies you want to print.  As you can see, the number 1 
is already selected by default, and for a draft copy that is certainly as many as you 
would normally want. 

Manually feeding pages into the printer 
Different printers have different options, but you should be able to put the paper into 
the printer manually, one sheet at a time.  The option to print All Pages in Range is 
selected by default, and this is what you will want for this exercise.  But if you click on 
the Properties button in the upper right corner of the dialog box, you can see that you 
have the option under Page Setup to hand feed (manually feed) paper into your printer 
one sheet at a time.  When this option is selected, Word will stop printing at the end of 
every page and wait for you to put a new sheet of paper in the printer.  This option is 
useful when you need to run off resum?s or other such documents that might need 
special quality paper, or when you need to run off a document on letterhead. 
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You are now ready to print the document. 

Click on OK in the Print dialog box 

If all is well with your printer connections and so forth, your printer will now go 
ahead and produce a hard copy of your document. 

Removing your document from the printer 
If you are using a laser printer or an ink jet printer, removing the paper from the printer 
is simply a matter of picking it out of the paper tray. 

Here are the steps to follow if you are using continuous form paper with a dot 
matrix printer (now relatively rarely seen in computing environments). 

Hit the Select button on the printer (the green light will go off) 
Press the Form Feed button (the paper will advance to the top of the next 
page) 
Press the Select button again (the green light will go back on) 
Carefully remove your document by tearing along the serrated edge 

First time users of dot matrix printers will find it tricky removing the printed 
document from the printer.  Don't be surprised if you damage the page as you learn to 
get used to tearing along the serrated edge.  This is another good reason to start by 
producing draft copies of your documents. 

Save the environment 
A useful environmental tip, for your draft copies, is to recycle paper which has 
one side blank.  Keep a box near the printer where folks can deposit paper they 
no longer want and which is clean on one side.  Only use new paper for a final 
copy of a document. 

Now you should take the time to carefully read over what you have typed.  If you 
used the Spell Checker, remember that it will not necessarily pick up all errors.  If you 
type "me" when you meant to type "he," the checker won't mind in the least, since both 
words are in the dictionary.  As we noted earlier, the golden rule here is: A Spelling 
Checker is only as good as you are!  You should never rely blindly on the feedback from 
the Spelling Checker.  So always proofread your writing—and tell your students to do 
the same.  You might also have your students proofread each other's papers.  Let them 
be teachers, too; it's a great way to learn! 

You should also check the overall page layout to see that the document looks good 
on the page.  If there are problems, now is the time to fix them.  Make all necessary 
changes on the computer and save the file again on your Data disk. 

If all is well, you are ready to go ahead and print the final version, the one that you 
will send in the mail to the parents. 
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1.7 RUNNING OFF A FINAL COPY 
Follow the steps you learned above to run off a final copy of your document.  If you are 
using a dot matrix printer and have a good ribbon, the resulting Conference Call letter 
should have a satisfactory appearance. 

Most printers today will accept single sheets of paper.  So if you wanted to use your 
school's letterhead, this would be no problem.  You would, of course, need to remove 
the sender's address from the top of your Conference Call letter since this address 
would already be included on the letterhead paper.  You would also need to select 
manual feed for the printer. 

 

1.8 MAKING A BACKUP COPY OF THE DOCUMENT 
Your last task before completing this session at the computer is to make a backup of 
your document on another disk.  Earlier in this lesson you were asked to prepare a 
backup disk for all your work.  Now is the time to learn how to make a backup copy of 
a single file. 

The Conference Call letter (ConfCall) is still open in Word.  It is also saved on your 
Data disk, which is in the disk drive. 

Close the Word word processing program 

Close or minimize any other windows that may be open on your desktop to 
make it easier for you to see what you’re doing 

Double click to open the My Computer icon, then double click on 3 1/2 
floppy A: 

Now drag the folder WPFiles from your Data disk to the Desktop and drop it 
there 

Watch while Windows makes a copy of your files on to the desktop, then 
close the Window on your Data disk 

Remove your Data disk from the disk drive, replace it with your DataBkp disk 
and double click on 3 1/2 floppy A: 

Now drag the WPFiles folder from the desktop to your DataBkp disk 

 

LOOKING BACK 
In this tutorial you have learned the basics of Microsoft Office 2000 word processing.  
You now know how to enter text, save it, revise it, set margins, check it for spelling, and 
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print it on paper in draft, standard, or letter quality.  You also learned one way to make 
a backup copy of your files. 

Many computer users learn no more than has been covered in this lesson.  Under–
utilization is an unfortunate fact of life when using a computer.  Ideally, however, this 
tutorial should have made you keen to learn more about Word.  Remember what you 
learned in Lesson 1.  You may need to refer back to some of the details spelled out here 
once you are using the word processor on your own. 

 

LOOKING FORWARD 
This has been a good introduction to the Microsoft Office 2000 word processor.  
However, there is still a great deal to learn.  Lesson 2 will give you an opportunity to 
further advance your skills. 

Many of the word processing skills that you have learned will transfer across to 
other word processors.  The more you use the computer as a tool for writing, the more 
natural it will become and the more you will improve your writing ability.  The ease 
with which you can make changes will have a significant impact on your willingness to 
generate quality written communication.  Needless to say, word processing will have 
the same effect on your students, so the sooner you can get them using the computer for 
all their writing assignments the better.  

 

SKILL CONSOLIDATION 
Complete these exercises to reinforce what you have learned in Lesson 1. 
1. Use Word to write a letter to someone in your family or to a friend using the same 

layout as the Conference Call letter.  Print out the letter in draft mode, proofread it, 
correct any errors, then print out the letter in letter quality mode. 

2. Write a letter to a school district superintendent explaining the details of a field trip 
that you are planning for your class.  Print out the letter in draft mode, proof read it, 
correct any errors, then print out the letter in letter quality mode. 

3. Write a short story using the word processor.  Set the right and left margins at 1.5 
inches.  Print out the story in draft mode, proof read it, correct any errors, then print 
out the story in letter quality mode. 

4. Use the word processor to type up a paper of your choice.  Print out the paper in 
draft mode, proof read it, correct any errors, then print out the paper in letter quality 
mode.  This will help you appreciate the usefulness of the word processor for all 
your writing tasks. 

5. Using the word processor, type a paper explaining what you have learned so far in 
tutorial 1.  Print out the paper in draft mode, proof read it, correct any errors, then 
print out the paper in letter quality mode. 
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6. Call up the Microsoft Office 2000 word processor to create a new file.  Name the file 
"Nonsense" and type in half a dozen sentences.  Then practice adding and deleting 
words, phrases, and whole sentences.  Print out the file in draft mode, proof read it, 
correct any errors, then print out the file in letter quality mode. 

7. Load the file "Conference Call Letter", change the date so that it is the current date, 
save the updated file.  Remove all the first line indents from the paragraphs.  Add a 
paragraph explaining that if Aaron cannot attend the Institute this year, the offer 
will be open again next year.  Save the updated file.  Proof read it, correct any errors, 
then print out the letter. 

 


